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To start off this large book on Adobe Acrobat, let’s first take a look at 
what Acrobat is and what PDF is, and let’s try to get a grasp on some 
of the many options you have for working with PDF files in Acrobat.

What Is Adobe Acrobat?
Assuming you know little about Adobe Acrobat, I start with a brief description 
of what Acrobat is and what it is not. As I explain to people who ask about the 
product, I usually define it as the most misunderstood application available 
today. Most of us are familiar with the Adobe Reader software, which is a 
product from Adobe Systems Incorporated that you can download free from 
the Adobe Web site (www.adobe.com/acrobat/readermain.html). 
You can also acquire the Adobe Reader from all the installation CD-ROMs for 
other Adobe software. You can even acquire Adobe Reader from other sources, 
as long as the Adobe licensing requirements are distributed with the installer 
program. The Adobe Reader, however, is not Adobe Acrobat. Adobe Reader is 
a component of a much larger product family that has evolved through several 
iterations over more than a decade.

You’re probably a little more sophisticated and realize there is a major differ-
ence between these applications, and you may wonder why I even spend any 
time discussing the difference between Acrobat and Adobe Reader. 
Unfortunately, many people still believe that Adobe Acrobat is the free 
Adobe Reader program.

To add a little more confusion, Adobe continues to market several Acrobat 
products in the Acrobat family. While Adobe Reader remains a free down-
load from Adobe Systems, there are three additional commercial viewers — 
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Acrobat Standard on Windows only), Acrobat Pro (on Windows and Macintosh), and Acrobat Pro 
Extended (includes functionality of the former Acrobat 3D and on Windows only). With the 
release of Acrobat 9, Acrobat Standard on Windows has been improved and offers many new fea-
tures formerly reserved for the Acrobat Pro product. As I talk about Adobe Acrobat in this chapter 
and throughout the book, I’m referring to Acrobat Pro for both Windows and Macintosh, Acrobat 
Pro Extended for Windows, and Acrobat Standard for Windows users only. Where the programs 
differ in features, I point them out. I also mention when a feature is only available in Acrobat Pro 
or Acrobat Pro Extended.

NOTENOTE There are distinctions between the Acrobat Standard product (Windows) and the 
Acrobat Pro and Acrobat Pro Extended (Windows) products in terms of tools, com-

mands, and features. Most editing tasks can be handled in all viewers; however, Acrobat Pro 
does provide more editing features than Acrobat Standard, and Acrobat Pro Extended provides 
more features than Acrobat Pro. Throughout this book I delineate the differences and point out 
when a feature is unique to a given viewer.

Adobe Acrobat (Standard, Pro, or Pro Extended) in version 9 is the upgrade from Adobe Acrobat 8 
(Standard, Professional, and/or Acrobat 3D) and all viewers are the subject of the remaining chap-
ters of this book. Acrobat is the authoring application that provides you tools and commands for a 
host of features outlined in the following chapters. If you haven’t yet purchased a copy of Acrobat, 
either the Standard version (Windows only), the Pro version (Windows and Macintosh), or the Pro 
Extended version (Windows), you might want to look over Chapter 2 and observe some of the 
comparisons between the viewers. If fewer tools and features suit your purpose, you might find the 
Standard version satisfactory — but remember, Acrobat Standard is available only on Windows in 
versions 8 and 9. Although some of the features differ between the viewers, they both provide 
many features for editing, enhancing, printing, and working with PDF documents.

NOTENOTE For the purposes of clarity, henceforth I’ll refer to Acrobat when features are com-
mon to all viewers. I’ll make specific mention of one of the Acrobat products when 

a particular feature is unique to a given viewer. For a quick comparison of the viewers and 
related features, be sure to look over Chapter 2.

Acrobat is an authoring application, but it has one little feature that distinguishes it from almost 
any other authoring program. Rather than starting from scratch and creating a new document in 
Acrobat, your workflow usually involves converting a document, created in just about any pro-
gram, to a Portable Document Format (PDF) file. Once converted to PDF you use Acrobat to edit 
and refine the document, add bells and whistles and interactivity, or prepare it for professional 
printing. In addition to the Acrobat program, Acrobat Pro ships with companion programs such as 
Adobe Acrobat Distiller, Adobe Acrobat Catalog, and Adobe LiveCycle Designer (Windows only). 
Acrobat Professional Extended ships with all the Acrobat Pro components and Adobe Presenter 
and Adobe 3D Reveiwer, Acrobat Standard ships only with Acrobat Distiller. These companion 
products are used to convert PostScript files to PDF, create search indexes, and author XML-based 
forms.
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CROSS-REFCROSS-REF For information related to Acrobat Distiller see Chapter 10. For more information on 
Acrobat Catalog, see Chapter 6. For more information related to LiveCycle 

Designer, see Chapter 35.

Acrobat solutions are greatly extended with other supporting programs from Adobe Systems and 
many different third-party vendors. If Acrobat can’t do the job, chances are you can find a plug-in 
or companion program to handle all you want to do with a PDF file.

CROSS-REFCROSS-REF For information related to Acrobat plug-ins and companion products see Chapter 2.

What Is PDF?
PDF, short for Portable Document Format, was developed by Adobe Systems as a unique format to 
be viewed through Acrobat viewers. As the name implies, it is portable, which means the file you 
create on one computer can be viewed with an Acrobat viewer on other computers, handheld 
devices, and on other platforms. For example, you can create a page layout on a Macintosh com-
puter and convert it to a PDF file. After the conversion, this PDF document can be viewed on a 
Linux or Windows machine.

Multiplatform compliance (to enable the exchange of files across different computers, for example) 
is one of the great values of PDF documents.

So what’s special about PDF and its multiplatform compliance? It’s not so much an issue of view-
ing a page on one computer created from another computer that is impressive about PDF. After all, 
such popular programs as Microsoft Excel, Microsoft Word, Adobe Photoshop, Adobe InDesign, 
Adobe FrameMaker, and Adobe Illustrator all have counterparts for multiplatform usage. You can 
create a layout on one computer system and view the file on another system with the same soft-
ware installed. For example, if you have Adobe InDesign installed on a Macintosh computer and 
you create an InDesign document, that same file can be viewed on a PC with InDesign running 
under Windows.

In a perfect world, you may think the capability to view documents across platforms is not so spe-
cial. Document viewing, however, is secondary to document integrity. The preservation of the con-
tents of a page is what makes the PDF so extraordinary. To illustrate, suppose you have an 
InDesign document created in Windows using fonts generic to Windows applications. After it’s 
converted to PDF, the document, complete with graphics and fonts intact, can be displayed and 
printed on other computer platforms. And the other computer platforms don’t need the fonts, 
graphics, or the original authoring application to print the file with complete integrity.

This level of document integrity can come in handy in business environments, where software pur-
chases often reach quantum costs. PDF documents eliminate the need to install all applications 
used within a particular company on all the computers in that company. For example, art depart-
ment employees can use a layout application to create display ads and then convert them to PDF 
so that other departments can use the free Adobe Reader software to view and print those ads for 
approval.
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The benefits of PDF viewing were initially recognized by workgroups in local office environments 
for electronic paper exchanges. Today users have much more opportunity for global exchange of 
documents in many different ways. As you look at Acrobat and discover some of the features avail-
able for document comment and markup, comparing documents, support for layered files (which 
adds much more functionality to Adobe Reader), and preparing PDFs for screen readers, you’ll see 
how Acrobat and the PDF have evolved with new technologies.

CROSS-REFCROSS-REF The term “screen reader” is used extensively throughout this book. When you see a 
reference to “screen reader,” I’m referring to either a hardware device or special 

software (JAWS, Kurzweil, and so on) used to convert visual information to audio format. For 
more information on screen readers and making documents accessible to the readers, see 
Chapter 25.

Document repurposing
The computer revolution has left extraordinary volumes of data that were originally designed to be 
printed on paper on computer systems. Going all the way back to UNIVAC, the number crunching 
was handled by the computer and the expression was the printed piece. Today, forms of expres-
sion have evolved to many different media. No longer do people want to confine themselves to 
printed material. Now, in addition to publishing information on paper, we use CD-ROMs, the 
Internet, file exchanges, and meeting sessions via the Internet between computers. Sometimes we 
use motion video, television, and satellite broadcasts. As high-speed access evolves, we’ll see much 
larger bandwidths, so real-time communication will eventually become commonplace.

Technology will advance, bringing many improvements to bandwidth, performance, and speed. To 
enable the public to access the mountains of digital data held on computer systems in a true infor-
mation superhighway world, files need to be converted to a common format. A common file for-
mat would also enable new documents to be more easily repurposed, to exploit the many forms of 
communication that we use today and expect to use tomorrow.

Acrobat Pro has many tools for helping users repurpose documents. Tools for repairing problem 
files, downsizing file sizes, porting files to a range of different devices, and eliminating unnecessary 
data are part of the many features found in Acrobat Pro. In addition, the PDF/A format introduced 
in Acrobat 8 is designed specifically for archiving documents. A standards committee has devel-
oped this format so documents viewed on computer systems 100 years from now will be compati-
ble with future operating systems.

PDF and Adobe PostScript
The de facto standard for nearly all printing in the graphics industry has been Adobe PostScript. 
While PostScript is still the dominant printing language, this will slowly change because Adobe has 
announced in 2006 support for PDF as the new print standard.
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Okay, so how does PostScript relate to PDF? In the initial release of Acrobat, all PDF conversion 
began with a file that was created as a PostScript file. Users selected the Print command in an 
authoring program and printed the file to disk — thus creating a PostScript file. This file was then 
opened in the Acrobat Distiller program and Distiller converted the PostScript to a PDF.

Distiller is still a part of Acrobat. In some cases, creating a PDF from a PostScript file rather than 
through any of the many other means available may be preferable. It could be that you have a 
problem with exporting to PDF from a program, such as fonts not appearing embedded, or you 
may need to create a PDF for a special purpose such as printing and prepress. In such circum-
stances using Acrobat Distiller may be your best solution for generating a PDF document to prop-
erly suit the purpose.

CROSS-REFCROSS-REF For information related to printing PostScript files and using Acrobat Distiller see 
Chapter 10.

Printing to PostScript and opening PostScript files in Distiller is used much less today because now 
so many programs support PDF creation through one-button clicks or using the Save As com-
mand. However, many of these one-button clicks still use the Distiller application in the back-
ground to create the PDF file. You may not see Distiller launched when PDFs are created in the 
background, but the program is working away to convert your authoring application document to 
a PDF file.

PostScript can be a problem solver for you, and you may have an occasional need to use it even if 
your workflow does not require its use all the time. The more you know about PostScript and 
Acrobat Distiller, the more often you might be able to rescue problem files that don’t seem to prop-
erly convert to PDF.

PDF versions
Acrobat is now in version 9. The version number indicates the number of releases of the product. 
PDF is a file format and with it you’ll also find a version number — that is, up until version 9 of 
Acrobat. The PDF version in versions prior to 9 related to the specifications of the file format; for 
the end user it’s usually not so important to understand all the specifications as much as it is to 
know what it does for you or what you can expect from it. If you create PDF documents for users 
of older Acrobat viewers and use the newer PDF format, your users may not be able to view your 
PDF files. Conversely, creating PDF files with the older version might prohibit you from using 
some newer features in the recent release.

PDF versions are typically referred to as Acrobat Compatibility. A PDF version 1.7 file, for exam-
ple, is an Acrobat 8–compatible file. To understand how the PDF version relates to the Acrobat 
version, simply add the digits of the PDF version together. For example, PDF version 1.4 is 
Acrobat 5 compatible (1 + 4 = 5). PDF version 1.5 is Acrobat 6 compatible, and so on.
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Now in version 9 however, PDF has lost its version number — the reason being, Adobe no longer 
owns the PDF specification. PDF has become an adopted standard by the International 
Organization for Standardization (ISO). Since the ISO committee sets the standard, it’s taken out of 
the hands of Adobe and no longer carries a version number.

Each release of Acrobat provides support for additional features in PDF documents. It’s not as 
important to know all the features enabled by one version as it is to know which Acrobat compati-
bility you need to use. For example, to optimize a PDF file for printing, you may need to use PDF 
version 1.3 or Acrobat 4 compatibility. Or, if you want to embed movie files in a PDF, then you 
need to use an Acrobat 6–compatible file. Or, you may want to add password security to a PDF 
that requires a newer Acrobat viewer to open a file using a password.

Whereas you previously may have thought of PDF version files, you now need to think in terms 
of Acrobat version compatibility. The PDF specification is handled by ISO, but the Acrobat 
compatibility is handled by Adobe Systems. ISO 32000 is the ISO specification for the current 
PDF version.

Understanding PDF Standards
PDF has been adopted as a standard file format in many industries, including engineering, legal, 
manufacturing, and prepress and printing. Even the United States Federal Government has 
embraced PDF as a standard file format.

So what are standards? Without regulation and approved standards, the computer industry would 
be chaotic. Fortunately, the International Organization for Standardization (ISO) develops and 
approves standards for the technical industry. This international committee, an entity apart from 
Adobe Systems, has approved and developed substandards of the PDF format.

The PDF standards available now include the following:

� PDF/X. This standard is a subset of the PDF format used in the printing industry. PDFs 
meeting PDF/X compliance are typically reliable and, theoretically, can be accurately 
printed on almost any kind of PostScript device.

� PDF/E. This standard is a subset of the PDF format designed for engineers to insure that 
industrial designs and drawings comply with a PDF standard.

� PDF/A. This standard is a subset of the PDF format used for archiving documents. The 
standards committee wants to insure that the files you create today and save as PDF can 
be viewed by computers many years in the future. To do so, the PDFs you create for 
archival purposes can be saved as PDF/A documents.
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� PDF/UA. Although, as of this writing, this subset of the PDF format is in an early draft 
stage, you may be hearing more about it in the near future — about one to two years 
from this writing. The goal of this proposed new standard is to provide universal access 
(UA) to all users including those persons working with assistive devices (see Chapter 25 
for more on PDFs and assistive devices). The proposed new format is in the hands of the 
AIIMS Standards Board Committee that also proposed the PDF/X and PDF/A standards 
and submitted them to the ISO. People interested in participating on the committee can 
find more information at www.aiim.org/standards.asp?ID=27861.

Acrobat Environment
Acrobat provides you with features such as menu commands, toolbars, and palettes to accomplish 
work for whatever goal you hope to achieve with PDF documents. When you launch the program 
you see many of these features in the Acrobat window. Just so you know what is being referred to 
when I discuss accessing a feature in Acrobat, take a look at Figure 1.1 to understand the names 
used to describe the various areas of the new Acrobat workplace.

A Title bar. By default, the name of the file you open appears in the title bar. The title 
appearing in the title bar can change according to an option for displaying the Document 
Title in the Initial View properties.

CROSS-REFCROSS-REF For information related to Initial View and displaying Document Titles, see 
Chapter 5.

 Note that the left side of Figure 1.1 shows a PDF document opened in Form Edit mode 
while the right side of the figure is a PDF file opened in Viewer mode. See item J for more 
on Form Edit mode.

B Menu bar. The menu bar (Viewer mode) contains all the top-level menu commands. 
Many of these menu choices are also available from various actions associated with links 
and form fields when you choose the Execute a menu item command in the Actions 
Properties dialog box for links, form fields, and other features that permit associating an 
action with a command. When viewing files showing toolbars and menus for each open 
document, the Acrobat window appears as shown in Figure 1.1 on the right side of the 
figure. This view can be toggled off in a preference setting.

CROSS-REFCROSS-REF For information related to link actions and the Execute a menu item command 
action type, see Chapter 22. For more information on actions with form fields, see 

Part VI. For making preference choices for viewing PDFs, see “Customizing the Acrobat work-
place” later in this chapter.
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 FIGURE 1.1

The Acrobat Pro Extended workplace contains menus, toolbars, and palettes.
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C Toolbars. A number of individual toolbars are nested below the menu bar in the Toolbar 
Well. When preferences are set to view toolbars attached to each open document, you’ll 
see multiple sets of toolbars. Toolbars are marked with a vertical separator bar at the left 
side of the toolbar. This bar can be selected and dragged to move it out of the Toolbar 
Well.

CROSS-REFCROSS-REF For information related to working with toolbars, see the “Tools, task buttons and 
toolbars” section later in this chapter.

D Floating toolbar. Toolbars can be opened by accessing the More Tools window and 
selecting a toolbar name. When a toolbar is opened, it appears as a floating toolbar. 
Floating toolbars can be docked in the Toolbar Well.

E Navigation pane buttons. Individual panel buttons appear on the left side of the 
Navigation pane. Click one of these buttons to open the Navigation pane where you find 
menu commands from an Options pull-down menu or a context menu opened in the 
Navigation pane.
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F Pages panel. When you open the Pages panel, you’ll see thumbnail images of each page 
in your document and you’ll find many page-editing features available to you from the 
Pages panel pull-down menu.

CROSS-REFCROSS-REF For information related to using the many options available in the Pages panel, see 
Chapter 16.

CROSS-REFCROSS-REF To learn how to use the Comments panel options, see Chapter 20.

G Navigation pane. The Navigation pane can be expanded or collapsed. The view in Figure 
1.1 is an expanded view where the Pages panel is the active panel. To open the 
Navigation pane you can click a panel button to display the respective information asso-
ciated with that panel in the expanded panel window. Clicking again on the panel col-
lapses the view. You can also use the keyboard shortcut F4 to expand and collapse the 
Navigation pane.

H Document pane. The Document pane is the container for PDF files you see in Acrobat. 
When no file is open, the Document pane is empty. When you open a PDF document, 
the document appears in the Document pane.

I Toolbar. Tools that are used in Form Editing Mode.

J Form Editing Mode. From a menu command in the Forms menu, you can open the 
Form Editing Mode. Form Editing Mode is a new user interface introduced with Acrobat 
9 and is specifically designed for creating Acrobat PDF forms. This mode is available in 
Acrobat Standard (Windows), Acrobat Pro (Windows and Macintosh), and Acrobat Pro 
Extended (Windows). To exit Forms Edit mode and return to the Viewer mode shown on 
the right side of Figure 1.1, click the Close Form Editing button.

K Fields panel. The Fields panel is used for editing fields and only appears when you enter 
Form Editing Mode.

L PDF Form. A form appears in the Form Editing Mode Document pane when editing a 
form in Form Editing Mode.

CROSS-REFCROSS-REF For more information on Form Editing Mode and creating PDF forms, see 
Chapter 34.

For more detail on specific menu commands, tools, and palettes, see the related chapters to dis-
cover the different options available to you. All of the items discussed here are explained in more 
depth in subsequent chapters.

Menus
As with any program operating on a computer system that supports a Windows type of environ-
ment, you’ll notice menu commands at the top level of the Acrobat window. Users of previous ver-
sions will notice that Acrobat 9 features a editing mode that contains tools specific to creating PDF 
forms. If at first glance you don’t see an option you used in Acrobat 8, poke around the menus. 
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None of the Acrobat 8 features have been eliminated; they may just be in a different place or 
referred to by a different name.

File menu
The File menu is where you open and close documents, create PDF files, import and export certain 
data, access print commands, and find some other nifty new additions in Acrobat such as the new 
Acrobat 9 PDF Portfolios and collaboration features. The Mac and Windows operating systems dis-
play recent files in different menus. On the Mac in OS X you’ll find recently viewed documents by 
choosing File ➪ Open Recent File. This command opens a submenu where you can access recent 
documents. On Windows, a list of the recently viewed documents is located at the bottom of the 
File menu, as shown in Figure 1.2.

CROSS-REFCROSS-REF Note that the Start Meeting command that appeared in Acrobat 8 has been removed 
in Acrobat 9. A new Share Screen command is contained in the Collaborate sub-

menu as I explain in Chapter 29.

 FIGURE 1.2

Recently opened files in Windows appear at the bottom of the File menu. Macintosh users can display a 
list of recently viewed files by choosing File ➪ Open Recent File.
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Edit menu
As shown in Figure 1.3, the traditional Cut, Copy, and Paste commands are located in the Edit 
menu along with other familiar commands from Acrobat 8. There are no changes to the Edit menu 
from Acrobat 8.

 FIGURE 1.3

The Edit menu contains the same commands found in Acrobat 7.

View menu
The View menu (see Figure 1.4) contains all the commands you’ll use for viewing PDF documents. 
An addition to the View menu is the Cursor Coordinates command. This command displays a tiny 
window showing the coordinates of the cursor as you move it around the Document pane. The dis-
play units are controlled by opening the Preferences (Ctrl/Ô+K) and changing the Units preferences.

Document menu
The Document menu (see Figure 1.5) contains a collection of commands specific to document 
handling. Options in the Document menu have a few changes in Acrobat 9 compared to the 
options in Acrobat 8. Notice a new command — Split Document. This new command now enables 
you to split PDF files by number of pages, file size, and top-level bookmarks. Although the Paper 
Capture command hasn’t changed submenu commands, the new Clear Scan features in Acrobat 9 
greatly improve scanning and OCR conversion. Notice the Compare Documents command, which 
was formerly in the Advanced menu in earlier Acrobat viewers, has now been moved to the 
Document menu.

CROSS-REFCROSS-REF For information related to splitting documents see Chapter 16. For more informa-
tion on scanning documents, see Chapter 17. For more information on comparing 

documents, see Chapter 20.
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 FIGURE 1.4

The View menu contains commands for viewing PDF documents and navigating through pages and differ-
ent PDF files.

 FIGURE 1.5

The Document menu contains commands for editing documents.
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Comments menu
There’s not so much change you’ll find in the Comments menu in Acrobat 9, but selecting several 
different commands opens up windows and dialog boxes with some very impressive new features 
in Acrobat 9 (see Figure 1.6). For example, sending files for shared reviews opens a new wizard 
where you can choose to share reviews on Acrobat.com.

CROSS-REFCROSS-REF For details on working with Acrobat.com look over Chapters 4, 21, and 29.

 FIGURE 1.6

The Comments menu.

Forms menu
Perhaps the biggest change you’ll find in Acrobat 9 is the many new features related to creating 
Acrobat PDF forms (see Figure 1.7). A huge departure from earlier Acrobat features is that all the 
form-editing options that were reserved for Acrobat Pro viewers are now included in Acrobat 
Standard on Windows. In addition, the way you create forms has greatly changed in Acrobat 9. 
Notice the two new menu commands at the top of the menu. Choosing either command opens 
a new user interface called Form Editing Mode where PDF forms are authored. In addition, 
you’ll find a command that enables you to integrate PDF form data with the QuickBooks account-
ing software.

NEW FEATURENEW FEATURE Form Editing Mode is a new feature in Acrobat 9 where all your form authoring is 
performed in a new user interface.
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 FIGURE 1.7

The Forms menu contains commands specifically for working with forms and provides a gateway to open 
the Form Editing Mode.

CROSS-REFCROSS-REF For working with Acrobat PDF forms, see Chapters 33 and 34. For understanding 
more about Adobe Designer and XML forms (Windows only), see Chapter 35.

Tools menu
Several changes appear in the Tools menu shown in Figure 1.8. Notice that the Forms command 
that opened the Forms toolbar in Acrobat 8 has been removed in Acrobat 9. There is no Forms 
toolbar in Acrobat 9 since forms editing takes place in Forms Edit mode where you’ll find access to 
all the forms tools. The Measuring toolbar and the Object tool formerly found in the Acrobat 8 
Tools menu have been eliminated and replaced by the Analysis toolbar. In Acrobat 9 you’ll find the 
new Multimedia toolbar accessed by selecting Multimedia in the Tools menu.

 FIGURE 1.8

The Tools menu contains a collection of tools accessed from submenus. Select a tool group from the menu 
options to open a submenu.

CROSS-REFCROSS-REF For more information on using the Multimedia tools, see Chapters 7 and 23.

Advanced menu
The Advanced menu (see Figure 1.9) contains a collection of menu commands considered to be 
advanced Acrobat features. Several of these tools are not available to users of Acrobat Standard 
such as Batch Processing, the Redaction tools, access to Acrobat Catalog, Print Production, 
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Document Processing, PDF Optimizer, and Preflight some accessibility options are different in 
Standard. A few changes have been made in this menu in Acrobat 9. You’ll notice a slight rear-
rangement of the commands with Accessibility now appearing at the top of the menu and the dis-
appearance of the Compare Documents command that has been moved to the Document menu.

 FIGURE 1.9

The Advanced menu offers menu commands related to advanced editing features.

CROSS-REFCROSS-REF For information related to batch processing, see Chapters 18 and 36 (on the CD-
ROM). For information on using Acrobat Catalog, see Chapter 6. For information on 

using all the security commands see Chapter 26.

Window menu
The Window menu (see Figure 1.10) provides menu commands to assist you in viewing docu-
ments. No changes appear in the Window menu in Acrobat 9 compared to earlier viewers.

 FIGURE 1.10

The Window menu handles all the window views such as tiling, cascading, and splitting windows.

CROSS-REFCROSS-REF For information related to window views and the split window views, see Chapter 5.
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Help menu
The traditional help files added to your Acrobat folder at installation are found in the Help menu 
(see Figure 1.11). Various online help support is also located in this menu. You’ll notice the rear-
rangement of help items in Acrobat 9 and the elimination of the Getting Started menu choice.

CROSS-REFCROSS-REF For information related to Help documents and Help menus, see Chapter 3.

Submenus
An extensive number of submenus appear in menus contained in the top-level menu bar and 
from many different tools contained in toolbars. Note that on individual toolbars you see a down-
pointing arrow. Clicking the arrow opens a menu; some menus contain submenus. A submenu is 
denoted in Acrobat by a right-pointing arrow on the right side of a given menu command as 
shown in Figure 1.12. Select a command with one of these arrows adjacent to the command 
name and a submenu opens. In a few cases, you can find nested submenus where another right-
pointing arrow may be visible in a submenu. If you want to access the second submenu, move the 
cursor to the menu option containing a right-pointing arrow. To make a selection from a sub-
menu command, move the cursor to the desired menu command. When the menu command 
highlights, click the mouse button to execute the command.

 FIGURE 1.11

The Help menu gives you access to Help information on selected topics as well as access to the complete 
Acrobat Help document.

Context menus
Wherever you are in the Acrobat window — the toolbars, panels, Document pane, or the various 
editing modes — you can gain quick access to menu items related to your task by opening a con-
text menu. Context menus pop up in an area where you either click the right button on the mouse 
or use an appropriate key modifier. In Windows, right-click the mouse button to open a context 
menu. On a Macintosh, when not using a two-button mouse, press the Control key and click the 
mouse button. Context menu options relate to the particular tool you have selected from a toolbar. 
Selecting different tools provides you with different menu commands. In Figure 1.13 I opened a 
context menu with the Marquee Zoom tool selected.
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 FIGURE 1.12

To access a submenu, move the cursor to the command containing a right-pointing arrow and slide the 
cursor over to the submenu options. Click the desired command in the submenu to execute the command.

 FIGURE 1.13

With the Marquee Zoom tool selected, right-clicking (Windows) or Control+clicking (Macintosh) the 
mouse button opens a context menu. From the menu, scroll the list and select the desired menu command.

If you change tools in a toolbar and open a context menu, the menu options change to reflect 
choices with that particular tool. Likewise, a context menu opened on a panel offers menu options 
respective to the panel, as shown in Figure 1.14.
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 FIGURE 1.14

When a panel is open in the Navigation pane and you open a context menu, the menu options reflect 
tasks you can perform respective to the panel.

TIPTIP Opening a context menu on one of the icons in the Navigation pane opens a menu 
where you can add or remove panels from the pane. Additionally, you can hide the 

Navigation panel icons by opening a context menu in the Navigation pane and select Hide 
Navigation Pane Buttons. To bring back the Navigation Pane Buttons, press F4 on your keyboard 
or select View ➪ Navigation Panels ➪ Show Navigation Pane.

Context menus are a great benefit during your Acrobat sessions and using them helps you work 
much faster. Throughout this book I often make references to the different choices you have in 
selecting a tool or command. In most incidences, you find mention of context menus. Be certain 
you know how to open a context menu in Acrobat on your computer. For the remainder of this 
book, I’ll mention opening context menus without walking through the steps for how to open 
the menu.

Keyboard shortcuts
Pressing one or more keys on your keyboard can also open menus and invoke different com-
mands. When you become familiar with keyboard shortcuts that perform the same function as 
when using a menu or context menu, you’ll find yourself favoring this method for making different 
menu selections or grabbing a tool from a toolbar. Fortunately, you can learn as you work when it 
comes to memorizing keyboard shortcuts. As I’m certain you know, several shortcut combinations 
are noted in menu commands. You can learn these shortcuts when you frequently use a particular 
command. However, the keyboard shortcuts you see in the menu commands are just a fraction of 
what is available in Acrobat for quick access to commands and tools. For a complete list of all key-
board shortcuts, look over the Acrobat Help document you open by selecting Help ➪ Adobe 
Acrobat 9.0 (Standard, Pro, or Pro Extended) Help or pressing the F1 key.

NOTENOTE Pressing a single key to access a tool requires you to have your Preferences set to 
accept single keystroke shortcuts. See the steps for “Setting up the Acrobat envi-

ronment” later in this chapter for the proper Preferences settings.
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Tools, task buttons, and toolbars
Tools are grouped together in separate toolbars in the Toolbar Well below the menu bar. The 
default view when you launch Acrobat contains several toolbars visible in the Toolbar Well. You 
can remove various toolbars from the Well, move them around the Acrobat window, close them, 
and add different toolbars to the Toolbar Well.

In addition to loading and unloading toolbars, you can also add or remove individual tools from 
any toolbar. Before you learn how to add and remove individual tools, let’s first take a look at the 
Toolbar Well.

The Toolbar Well, where the toolbars are contained, is collapsed and expanded according to the 
number of toolbars you add to it. When a toolbar is contained within the Toolbar Well, it is said to 
be docked. When a toolbar is dragged away from the Toolbar Well and rests atop the Acrobat win-
dow, it is said to be undocked and appears as a floating toolbar.

Task buttons
One of the many different toolbars in Acrobat is called the Tasks toolbar. This toolbar houses vari-
ous Task buttons. In Figure 1.15 the tasks toolbar is shown with the label descriptions to describe 
each tool’s purpose. Task buttons differ a little from other tools in that they all support pull-down 
menus where menu commands related to specific tasks are addressed.

 FIGURE 1.15

The Tasks toolbar contains several Task buttons all containing pull-down menus.

The Tasks toolbar features commands for creating PDFs, combining files, working with reviews 
and online collaboration, securing PDFs, digitally signing PDFs, working with forms, working with 
multimedia, and working with comments.

Loading and unloading tools
The default tools you see in the Toolbar Well when you first open Acrobat are but a mere fraction 
of all the tools available to you. Fortunately in Acrobat, a nifty window is available to help you eas-
ily manage tools.

It’s important to realize that you have toolbars and tools. Tools appear as individual icons con-
tained in a given toolbar. You can choose to show only one tool in a toolbar or all the tools that 
belong to a given toolbar and anything in between. The tools within toolbars can be added and 
deleted from the parent toolbar.
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If you’re familiar with earlier versions of Acrobat and you don’t find tools loaded in the various 
toolbars, your first stop is to open the More Tools menu at the top right corner of your screen. 
Select More Tools from a context menu opened on the Toolbar Well and the More Tools window 
opens as shown in Figure 1.16.

 FIGURE 1.16

Open the More Tools window to show/hide tools in toolbars.

Place a check mark beside any tool to be shown in a toolbar docked in the Toolbar Well or opened 
as a floating toolbar. Figure 1.16 shows you a small portion of available tools that appear in a scrol-
lable window.

NOTENOTE Toolbars themselves can be shown or hidden using the More Tools window. If you 
remove a check mark adjacent to a toolbar name to hide the toolbar, the toolbar 

and all the tools are hidden, even if the individual tools are all checked.

Yet another way to add and remove tools to and from toolbars is to simply open a context menu 
on a toolbar. Right-click (Windows) or Control+click (Macintosh) on a toolbar either docked in 
the Toolbar Well or as a floating toolbar and a pop-up menu provides options for adding or 
removing tools to/from that toolbar group.

06_379196-ch01.indd   2206_379196-ch01.indd   22 9/24/08   8:40:05 PM9/24/08   8:40:05 PM



23

Getting to Know Adobe Acrobat 1

In Figure 1.17 a context menu is opened on the Edit toolbar. When Show/Hide Tools is selected a 
submenu displays all toolbars. Select an item unchecked to open the respective toolbar, or select a 
checked toolbar to remove/hide it. Note that hiding a toolbar is temporary and only hides the tool-
bar from view in the Toolbar Well.

 FIGURE 1.17

Open a context menu on a toolbar and select Show/Hide Toolbars to open a submenu where all toolbars 
can be opened or temporarily closed.

TIPTIP If you want all tools within a given toolbar to be shown, select Show All Tools in the 
context menu.

The Show/Hide menu command in the context menu shown in Figure 1.18 provides the same 
commands you have available in the View ➪ Toolbars submenu. Either of these menus provides 
you a quick and easy way to show and hide toolbars.

The last menu item in the context menu shown in Figure 1.18 is used to open the More Tools win-
dow where you can add/remove tools among all toolbars.

Default toolbars
When you launch Acrobat for the first time or you set the toolbars to the default view, six different 
toolbars are docked in the Toolbar Well, including the Tasks toolbar discussed earlier in this sec-
tion. The remaining default toolbars include:
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� File toolbar. These tools are used for general document handling. The default File tools 
activate commands for Open, Save, Print, and Email and Upload. When all the tools are 
loaded in the File toolbar the Create PDF from web page and Attach a File tools are 
added to the toolbar. In Figure 1.19 the File toolbar appears with all the File tools in 
view.

 FIGURE 1.18

The File toolbar contains tools for document handling, such as opening PDF documents, 
saving documents, and printing files.

� Page Navigation toolbar. The default tools in the Page Navigation toolbar shown on the 
left in Figure 1.19 contain tools for moving back and forth between PDF document 
pages. The numbers indicate what page you are currently viewing out of the total number 
of pages in the document. When the toolbar is expanded to show all tools as you see in 
Figure 1.19, the First Page, Previous Page, Next Page, Last Page, Previous View, and Next 
View tools are shown.

 FIGURE 1.19

The Page Navigation toolbar, as the name implies, contains tools for navigating docu-
ment pages.

� Page Display toolbar. The Page Display toolbar is the home of many different tools used 
for page viewing, but only two of the tools appear in the default toolbar. When you first 
open Acrobat, you see the Scrolling Pages and One Full Page tool. After expanding the 
toolbar to show all tools as shown in Figure 1.20, the Single Page Continuous, Single 
Page, Two-Up, Two-Up Continuous, Full Screen Mode, Rotate Counterclockwise, Rotate 
Clockwise, and Line Weights tools are shown.

 FIGURE 1.20

The Page Display toolbar contains many tools used for page viewing.
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� Select & Zoom toolbar. The tools in this group are used to select text/images, move the 
page in the Document pane, and zoom in and out of pages in the Document pane. Figure 
1.21 shows the Select tool followed by the Hand tool and then the Dynamic Zoom tool, 
the Zoom Out, Zoom In, Zoom Value tools, Actual Size, Fit Width, Fit Page, Pan & Zoom 
Window, Loupe tool, and Snapshot.

 FIGURE 1.21

Select & Zoom tools are used to select text/images, move a document around the 
Document pane, copy selections, and view the document page using a number of dif-
ferent zoom tools.

� Find toolbar. Of all the default toolbars, the Find toolbar shown in Figure 1.22 is the 
only one that does not have additional tools that can be added to the toolbar. However, a 
pull-down menu exists for making choices to refine your search for words in an open 
PDF document.

CROSS-REFCROSS-REF For more information on searching PDFs, see Chapter 6.

 FIGURE 1.22

The Find toolbar is used for searching words in a PDF document.

Managing default toolbars
In addition to loading and unloading tools within toolbars, the toolbars can be moved, docked, 
and undocked from the Toolbar Well. Here’s a list of some of the things you can do with the 
default toolbars and any other toolbars you decide to view:

� Undocking toolbars. Toolbars can be relocated from within the Toolbar Well to another 
area within the Acrobat window. For example, you might find it more convenient to 
move a toolbar you frequently access during an editing session so it is positioned at the 
right side of the Document pane. If so, just place the cursor on top of the vertical separa-
tor bar adjacent to the first tool in a toolbar and drag it away from the Toolbar Well. This 
vertical line is the hot spot used to select the toolbar instead of a tool in the group. 
Clicking anywhere else in the toolbar selects a tool.
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� Docking toolbars. To dock a toolbar back in the Toolbar Well once removed, drag the 
toolbar, again by the vertical separator bar adjacent to the first tool, on top of the Toolbar 
Well. The toolbar snaps to an available position in the Well. If you drop the toolbar 
between two other toolbars, the toolbar you relocate back to the Toolbar Well snaps in 
position between the two docked toolbars.

 Toolbars can also be docked vertically on the left and right sides of the Document pane 
and at the bottom of the Acrobat window below the status bar. For example, if you drag a 
toolbar to the left of the Navigation pane and release the mouse button, the toolbar snaps 
to a docking station and the tools display vertically. In Figure 1.23 you can see toolbars 
docked on the left (A), and right (B), with one floating toolbar (C) in the Document pane.

� Resetting toolbars: You can position toolbars around the Acrobat window and return 
them to the default positions with one menu command. This is particularly helpful if 
multiple users work on a single computer or you frequently change editing tasks that 
require using different tools during different editing sessions. In many cases it’s easier to 
reset toolbars to the original default view than open tools needed for a specific editing 
task. To set toolbars to their defaults, open a context menu from any toolbar or in the 
Toolbar Well by right-clicking (Control+clicking on Macintosh), and select the menu 
item Reset Toolbars as shown in Figure 1.24. Alternately, you can press Alt/Option+F8.

 FIGURE 1.23

Toolbars can be docked on all four sides of the Acrobat window and undocked from the 
Toolbar Well where they appear as floating toolbars.
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 FIGURE 1.24

To return toolbars back to the default view, open a context menu from any toolbar or in 
the Toolbar Well and select Reset Toolbars.

� Hiding all toolbars. Toolbars can be hidden from view to offer you more room when 
editing a PDF document or browsing the contents of PDFs. To hide the toolbars from 
view, open a context menu from the Toolbar Well and choose Hide Toolbars. When tool-
bars are hidden you won’t have access to a context menu to get the toolbars back in view. 
Instead, choose View ➪ Toolbars ➪ Show Toolbars to make all toolbars reappear. (Note 
that using this menu command also hides toolbars.)

� Hiding a single toolbar. You can hide a toolbar after it has been undocked from the 
Toolbar Well. Click the X in the top right corner of the toolbar (Windows) or the small 
circle on the top left side of the toolbar (Macintosh) to close it, and it disappears from 
view. From a context menu opened on any toolbar or the Toolbar Well, you can open 
the toolbar and display it in the Acrobat window again. Toolbars can also be hidden by 
using the More Tools window, opening a context menu on the Toolbar Well and select-
ing a toolbar with a check mark to hide it, and selecting toolbars in the View ➪ Toolbars 
submenu.

� Locking toolbars. The vertical separator bar used to move toolbars disappears when you 
select Lock Toolbars from a context menu. The toolbars cannot be inadvertently moved 
after you lock them. To unlock the toolbars, open a context menu and select Lock 
Toolbars again. The check mark alongside the menu command becomes unchecked and 
the toolbars are unlocked in the Toolbar Well. If the toolbars are locked and you drag an 
undocked toolbar on top of the Toolbar Well, it won’t dock. You need to first unlock the 
toolbars before you can redock them. Additionally, you need to unlock toolbars in order 
to use the Reset Toolbars command in a Toolbar Well context menu to return tools and 
toolbars back to the default position.
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NOTENOTE You can also lock toolbars that are undocked outside of the Toolbar Well. The sepa-
rator bar on the toolbar disappears on floating toolbars the same as it does for tool-

bars docked in the Toolbar Well. However, locking undocked toolbars does not prevent you 
from moving them around the Acrobat window. You can click and drag the title bar for any 
undocked toolbar and move it to another location.

� Setting new toolbar defaults. If you decide to reposition your toolbars and want to keep 
them fixed as new defaults, Acrobat can do so for you automatically. Move the toolbars to 
the desired locations and go about your work. When you quit Acrobat and reopen the 
program, the toolbar positions remain as you last arranged them. Unfortunately, Acrobat 
does not have a Save Workspace command like you find in several Adobe Creative Suite 
applications.

TIPTIP If you are unfamiliar with many Acrobat tools, you can change the tool labels to 
show you a more descriptive label for each tool that offers you a hint of what the 

tool does. To show more descriptive labels, open a context menu on the Acrobat Toolbar Well 
and choose Show Button Labels ➪ All Labels. The toolbars expand and show a text description 
for each tool’s name. Keep this option active until you are familiar with the tool names.

Understanding advanced toolbars
The default toolbars represent a fraction of the tools available to you in Acrobat. Many of the other 
toolbars remain hidden from view. The reason for this is obvious when you load all the toolbars in 
the Toolbar Well. You lose a lot of viewing real estate when all toolbars are docked in the Toolbar 
Well. Unless you have a large display monitor or a second monitor, working on a file in the 
Document pane when all toolbars are in view gives little room to see document pages. Fortunately, 
by managing the toolbars you can elect to show only the tools you want to work with and you can 
move them around the Acrobat window, allowing for the best view.

You open toolbars from menu commands in the Tools menu or by opening a context menu on the 
Toolbar Well. If you’re a seasoned Acrobat user, your first encounter with Acrobat viewers 6 and 
above might be a bit frustrating if you don’t know how to access the tools you want to use. “Where 
is that Form tool?” you may ask. Don’t worry; it’s there. You just have to poke around and search 
for it or, better yet, look over the following descriptions to understand more about how these other 
tools are grouped into separate toolbars.

Opening advanced toolbars
For the purpose of discussion, I’ll refer to the non-default toolbars as advanced toolbars. Acrobat 
does not refer to all these tools as advanced tools. Some of the tools labeled in the menu com-
mands are not referred to as advanced tools. For clarity in this chapter, though, consider all the 
following toolbars as advanced toolbars.

You can use three methods for displaying toolbars not visible when you open Acrobat. You can 
open the View ➪ Toolbars menu where you find a list of tools in submenus. Select a submenu item 
to open a toolbar as a floating toolbar in the Acrobat window. Another method is to open a context 
menu on the Toolbar Well and open toolbars from commands in the menu. A third option, and 
one that provides more options for viewing all tools and toolbars in a single window, is to use the 
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More Tools menu command when you open a context menu on the Toolbar Well. As a matter of 
routine, you should use this option when preparing an Acrobat session that requires you to use 
several tools and toolbars. All tools except the Form tools Pro are accessible from the context 
menu.

Analysis toolbar
In Acrobat 8 you had the Measuring toolbar and the Object Data tool opening in two separate tool-
bars. These two toolbars have been added to a new toolbar in Acrobat 9 shown in Figure 1.25. In 
addition to these tools you find the Geospatial Location tool and the Geospatial Registration tool 
(Acrobat Professional Extended only) that enable you to view geospatial data on maps.

 FIGURE 1.25

The Analysis toolbar combines the Measuring tools and the Object Data tool with the new Geospatial 
tools added in Acrobat Professional Extended.

Advanced Editing toolbar
The Advanced Editing toolbar shown in Figure 1.26 is one you’ll use in just about all Acrobat edit-
ing sessions. Tools include the Select Object tool that is used to select content you add in Acrobat 
such as comment markups and form fields. The Article tool is used to create article threads; the 
Crop and Link tools follow. The TouchUp Text tool is used to edit text on a page, the TouchUp 
Reading Order is used with accessibility editing, and the last tool is the TouchUp Object tool that 
is used to select objects such as vector objects and images.

NEW FEATURENEW FEATURE You’ll notice that the Advanced Editing toolbar does not contain the Movie tool and 
the Sound tool. These tools have been moved to the new Multimedia toolbar in 

Acrobat 9. Also notice you have the Button tool in the Advanced Editing toolbar but no access to 
the other form tools. See “What happened to the Forms tools?” later in this chapter.

CROSS-REFCROSS-REF For more information about PDF editing using the Advanced Editing tools, see the 
chapters in Part III. To learn more about the Link tool, see Chapter 22. To learn how 

to use the TouchUp Reading Order tool that follows the TouchUp Text tool, see Chapter 25.

 FIGURE 1.26

The Advanced Editing toolbar contains a miscellaneous group of tools used for many different editing 
functions.
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Comment & Markup toolbar
When you open either the View ➪ Toolbars submenu menus or a context menu on the Toolbar 
Well, the first menu option after the default Advanced Editing toolbar is the Comment & Markup 
toolbar. Additionally, you can open the Comment & Markup toolbar from the Comment task but-
ton pull-down menu and a menu command in the Comments menu. Select the menu option and 
the Comment & Markup tools open in their own toolbar. Open a context menu on the toolbar and 
select Show All Commenting Tools. The toolbar appears as you see in Figure 1.27 when all tools 
are loaded.

 FIGURE 1.27

Open the Comment & Markup toolbar and open a context menu on a tool and select Show All Tools to 
see all the comment and markup tools.

TIPTIP When you select the Comment & Markup tools from the More Tools window and 
check the boxes for all tools, all the tools are loaded except the Paste a copied 

image as stamp tool. To show the tool in the Comment & Markup toolbar, open the Comment & 
Markup toolbar and open a context menu on any tool in the toolbar. Select Show All Tools and 
the Paste a copied image as stamp tool is added to the toolbar.

CROSS-REFCROSS-REF For more information on using all the Comment & Markup tools, see Chapter 20.

Edit toolbar
The Edit toolbar is the home of a miscellaneous group of editing tools, such as spell-checking, 
copy, undo, and redo. (See Figure 1.28.)

 FIGURE 1.28

The Edit toolbar contains a miscellaneous selection of tools used for spell-checking and editing.

Multimedia toolbar
The Multimedia toolbar combines the Movie, Sound, and 3D tools found in the Advanced Editing 
toolbar in earlier versions of Acrobat along with the new Flash tool. Note that the Movie tool has 
been renamed as the Video tool (See Figure 1.29).

CROSS-REFCROSS-REF For more information about using the Multimedia tools, see Chapter 23.
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 FIGURE 1.29

The Multimedia toolbar offer options for adding media to PDF documents.

Print Production toolbar
The Print Production toolbar (see Figure 1.30) enable you to make adjustments on the PDF or alter 
the content. This toolbar contains tools for assigning traps, preflighting, converting colors, assign-
ing color profiles, adding crop marks, cropping pages, fixing hairlines, transparency flattening, and 
assigning Job Definitions.

 FIGURE 1.30

Use the Print Production tools to open dialog boxes where you can preview and change PDF documents 
to accommodate prepress and commercial printing.

CROSS-REFCROSS-REF For more information on using Print Production tools and preparing files for com-
mercial printing, see Chapter 32.

Redaction toolbar
The Redaction tools are particularly helpful for users who need to remove text content from docu-
ments to protect sensitive data such as the names of minors, personal privacy information, and 
data breeching security policies. When you open the Redaction toolbar you’ll see four tools to help 
you redact PDF documents as shown in Figure 1.31.

 FIGURE 1.31

Redaction tools are used to remove sensitive information from PDF documents.

CROSS-REFCROSS-REF For a complete explanation of redaction and using the Redaction tools, see 
Chapter 14.
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Typewriter toolbar
The Typewriter tool was added to all Acrobat viewers in a maintenance upgrade during the 
Acrobat 7 life cycle. This toolbar, shown in Figure 1.32, contains tools for typing text on PDF doc-
uments. It’s particularly helpful when filling out PDF forms that don’t have form fields. Notice the 
new additions in Acrobat 9 for changing fonts, font colors, and font point sizes.

 FIGURE 1.32

New additions to the Typewriter tool include changing fonts, font colors, and font point sizes.

CROSS-REFCROSS-REF For more information on using the Typewriter tools, see Chapter 33.

Properties Bar
You use the Properties Bar (see Figure 1.33) in conjunction with several different tools. After you 
create comments, links, buttons, and similar content in a PDF document, the selected comment, 
link, button, and so on displays current properties such as colors, fonts, and line weights in the 
Properties Bar. You can make changes in the Properties Bar without visiting the Properties dialog 
box. You can quickly open the Properties Bar with a keyboard shortcut (Ctrl/Ô+E) or via a context 
menu opened on the Toolbar Well.

 FIGURE 1.33

The Properties Bar offers a quick solution for editing item properties without the need for opening dialog 
boxes.

What happened to the Forms tools?
Don’t be alarmed when you first open Acrobat 9 and look for the Forms toolbar. The form tools 
are all available to you but they don’t appear in the current viewer mode when you open a PDF 
document. You need to change modes to the new Acrobat 9 Form Editing Mode.

NEW FEATURENEW FEATURE Choose Forms ➪ Start Form Wizard or Add or Edit Fields and you’ll change the inter-
face mode to Form Editing Mode. Instead of a toolbar housing the Form tools, you’ll 

find all the same form tools available to you under the Add New Field pull-down menu as shown 
in Figure 1.34.

06_379196-ch01.indd   3206_379196-ch01.indd   32 9/24/08   8:40:09 PM9/24/08   8:40:09 PM



33

Getting to Know Adobe Acrobat 1

 FIGURE 1.34

Enter Form Editing Mode and choose a form tool from the Add New Field pull-down menu.

Form Editing Mode does have a toolbar; however, the Form Editing Mode toolbar is not one that 
you can undock from the area reserved for toolbars. Toolbars are fixed to a location similar to the 
Acrobat Toolbar Well in Form Editing Mode appearing at the top of the window. If you want the 
individual tools to appear without having to open the Add New Field menu, open the menu and 
choose Show Tools on Toolbar. The individual form tools are displayed on the Form Edit toolbar 
as shown in Figure 1.35.

 FIGURE 1.35

Open the Add New Field pull-down menu and choose Show Forms Toolbar to display the individual form 
tools in the Form Edit toolbar.

Customizing the Acrobat workplace
Whether you’re an Acrobat pro or a new Acrobat user, seeing all those toolbars loaded and scat-
tered across the Toolbar Well for the first time can be very intimidating. As you poke around and 
possibly feel a little frustration when trying to identify the right tool icon to select the right tool for 
the task at hand, please realize that Acrobat is a multifaceted program serving a huge array of needs 
for different users. Not all the tools and features are designed for use in a single Acrobat session. 
You may be a PDF forms author with a need only for Basic tools, Navigation tools, Edit tools, and 
who switches over to Form Editing Mode. In another session you may be a reviewer and only have 
need for the Comment and Markup tools. You might be an eBook author and need to work with 
many features for creating and viewing eBooks, or you might want to edit PDF pages and post 
modified PDFs on your Web site.

When learning all the tools and commands contained in Acrobat, be certain to look over all the 
chapters where tools are discussed. Learn how to access toolbars and organize them in the Toolbar 
Well. When you begin a new Acrobat session, set up your environment so you can easily select a 
tool from toolbars you dock in the Toolbar Well.
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As a starting point, you can configure Acrobat to provide you with immediate feedback related to 
tools selection and keyboard shortcuts. As you first start using Acrobat, follow the steps in the next 
section to help you customize your environment for more efficient editing and less frustration. In 
this example, an environment for engaging in a commenting session is used. You can change the 
toolbars to meet needs in PDF editing or PDF creation, or add tools for some other kind of work 
you do.

STEPS: Setting up the Acrobat environment

 1. Return to toolbar defaults. Open Acrobat. Position the cursor on any area in the 
Toolbar Well and right-click to open a context menu (Control+click for Macintosh) and 
select Reset Toolbars.

 2. Open the More Tools window. From a context menu opened from the Toolbar Well, 
select More Tools to open the More Tools window.

 3. Add the tools you intend to use to the Comment & Markup toolbar. This is a per-
sonal choice. Look over all the Comment & Markup tools and check just those tools you 
intend to use. Be certain to check the box for the Comment & Markup toolbar so the 
toolbar shows up when you leave the More Tools window. (See Figure 1.36.)

 FIGURE 1.36

The More Tools window
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 4. Add some Edit tools. While still in the More Tools window, scroll to the Advanced 
Editing toolbar. One tool you’ll use frequently in almost all editing sessions is the Select 
Object tool (denoted with an arrowhead icon). Click the check box for this tool. Other 
tools won’t be used under most circumstances such as the Article tool, Link tool, and so 
on. Uncheck all the tools you anticipate not using.

 5. Add the Spell Check tool. Scroll to the Edit toolbar and check the Edit toolbar.

 6. Exit the More Tools window. When certain about the tools you think you’ll use in a 
given editing session, click OK and all the toolbars open as floating toolbars.

 7. Open the Properties Bar. Again open a context menu on the Toolbar Well and select 
Properties Bar from the menu options. Note that this tool is not available in the More 
Tools window and needs to be opened from a context menu or the View ➪ Toolbars 
submenu.

 8. Dock the toolbars. After opening all the toolbars you want to use for a given editing ses-
sion return to the Toolbar Well context menu and select Dock Toolbars. This command 
moves all the toolbars to the Toolbar Well, as shown in Figure 1.37.

 FIGURE 1.37

Toolbars docked in the Toolbar Well include the A) File toolbar, B) Select & Zoom tool-
bar, C) Advanced Editing toolbar, D) Edit toolbar, E) Comment & Markup toolbar, and F) 
the Properties Bar.

A

C EF

B D

Tooltips
When you select All Labels from a context menu or preference setting, you see tool descriptions on 
many tools. However, not all tools describe the tool with a label. For example, look at the Zoom In 
tool (the plus symbol). It should be apparent to you what the tool does by viewing the icon in the 
toolbar. Other tools’ functions, however, may not be so apparent from viewing the tool icons. 
Fortunately, you have some extra help in the form of tooltips. To view a tooltip, place the cursor 
over a tool in the Toolbar Well or on a floating toolbar, and pause a moment before selecting the 
tool. A tooltip appears inside a yellow box directly below the cursor with a label describing the 
tool. In Figure 1.38 you can see the tooltip that appears when the cursor is placed over the Sticky 
Note tool. As you move the cursor over different tools, the tooltips change to reflect the description 
of the targeted tool.
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 FIGURE 1.38

Place the cursor over a tool and pause a moment before selecting the tool. A tooltip describing the tool 
opens below the mouse cursor.

As you become familiar with the tools, you can return to the context menu opened from the 
Toolbar Well and choose Button Labels ➪ No Labels. When No Labels is active, your toolbars 
shrink and offer you more room in the Toolbar Well.

Panels
Other tools available to you in all Acrobat viewers are panels. Panels are similar to toolbars in that 
they can be docked to a docking station called the Navigation pane; they can be undocked and 
floated around the Acrobat window; they can contain pull-down menus for selecting more options; 
a series of default panels appears docked in the Navigation pane; and you can open additional pan-
els from menu commands.

A couple distinctions between toolbars and panels are that panels can be placeholders for informa-
tion, and tools can appear inside a panel. Whereas tools are used in the Document pane, many 
panel operations take place directly in the panel. Toolbars remain relatively fixed in size, but pan-
els can be sized and stretched along the Acrobat window to provide you with more room to work 
within the panel or view the information contained within the panel. In addition, some panels con-
tain their own tools where edits can be made in the panel and dynamically reflected on the docu-
ment page. Panels help you organize content, view specific content across many pages, and 
provide some tools for global editing of PDF files.

Default panels
As with toolbars, Acrobat displays a series of panels docked in a well when you first launch the 
program. Panels are contained in the Navigation pane along the left side of the Acrobat window. 
By default, the Navigation pane is collapsed; however, you can save PDF documents in such a 
manner where a panel expands when a file is opened in any Acrobat viewer. These settings are 
document-specific and can be toggled on or off for individual PDF documents.

CROSS-REFCROSS-REF For more information about setting opening views for panel displays, see Chapter 4.

Pages
  Acrobat users have been familiar with the thumbnail view of each page since the early days of 

Acrobat. A mini view of each page in the active PDF document is displayed in the Pages pane, as 
shown in Figure 1.39. The Pages pane offers you menu options for arranging, deleting, inserting, 
and editing pages in a number of ways. You can zoom in to the thumbnail views as large as or even 
larger than a page viewed in the Document pane.
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 FIGURE 1.39

Thumbnails are found in the Pages panel in all Acrobat viewers. The thumbnail view of document pages 
can be sized larger and smaller using context menu commands.

CROSS-REFCROSS-REF For a complete description of working with pages (thumbnails), see Chapter 16.

Bookmarks
  The second default panel in the Navigation pane is the Bookmark panel. You can save PDF docu-

ments in a manner where the bookmarks are visible when the file opens in Acrobat. Bookmarks are 
visible in an open Navigation pane, as shown in Figure 1.40. You can open and close the 
Navigation pane by pressing F4. You can also grab the vertical separator bar at the right edge of the 
Navigation pane and move it left and right to size the pane.

Bookmarks are navigation buttons that can launch a page, a view, or one of many different Action 
types similar to link and button actions. Anyone familiar with Acrobat already knows much about 
bookmarks and how to navigate pages by clicking individual bookmarks in the panel.
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 FIGURE 1.40

Bookmarks can be displayed in the Navigation pane when a file opens.

CROSS-REFCROSS-REF To learn how to create and manage bookmarks and add actions, see Chapter 17.

Signatures
  Digital signatures help you manage signed documents; the Signatures panel enables you to perform 

tasks such as displaying signatures in the Signature pane, verifying signatures, clearing them, 
deleting them, and so on. All these editing tasks with signatures are still available in Acrobat 
Professional and Acrobat Standard as is signature validation, which is also available in all Acrobat 
viewers.

CROSS-REFCROSS-REF For a complete description of creating and managing digital signatures, see 
Chapter 26.

Attachments
  The Attachments pane (see Figure 1.41) in all Acrobat viewers is used to display, manage, and 

extract file attachments. You can attach files in Acrobat and extract file attachments using all 
Acrobat viewers including Adobe Reader.

 FIGURE 1.41

The Attachments panel provides options for managing file attachments. Attachments can be extracted from 
within Adobe Reader.
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CROSS-REFCROSS-REF For a complete description of adding file attachments to PDF documents, see 
Chapter 15. For more on extracting attachments from within Adobe Reader, see 

Chapter 3.

Comments
  The Comments panel shows you comments in an expanded horizontal view, just like the 

Attachments panel. When you click the Comments panel, you’ll notice a number of pull-down 
menus (signified by down-pointing arrows at the top of the pane), a list of comments that can be 
expanded and collapsed, and a host of tools within the panel, as shown in Figure 1.42.

 FIGURE 1.42

The Comments panel

CROSS-REFCROSS-REF For a complete description of creating and managing comments, see Chapters 20 
and 21.

Hidden panels
As with toolbars, you can choose to view additional panels through menu commands. You can 
choose to display a number of other panels in the Acrobat window and dock them in the 
Navigation pane. To open a hidden panel, choose View ➪ Navigation Panels. From the submenu, 
you’ll find all the panels available. In Figure 1.43, the list shows Navigation panels available in 
Acrobat Pro Extended.

Another way to access the Navigation panels is through a context menu. Right-click (Windows) or 
Control+click (Macintosh) on the Navigation pane and a menu shows all the Navigation panels. In 
order to see the panels, you must first open them from the Navigation Panels submenu and dock 
them in the Navigation pane. Opening a context menu offers an additional menu command for 
Show/Hide Navigation Panel Buttons as shown in Figure 1.44.

The list includes the default panels. If you select a default panel, the Navigation pane opens and 
the panel is selected. When you select a hidden panel — in other words, a panel other than those 
docked in the Navigation pane when you first launch Acrobat — the panel opens in the Acrobat 
window as a floating panel with one or more panels contained in the window. Drag a panel to the 
Navigation pane and it docks and then becomes visible in a context menu opened from the 
Navigation pane.
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 FIGURE 1.43

Open the Navigation Panels menu and a submenu displays all Navigation panels.

 FIGURE 1.44

Once Navigation panels have been docked in the Navigation pane, they appear in a context menu opened 
from the Navigation pane.
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Articles
  The first of the hidden panels listed in the Navigation Panels submenu is Articles. Choose 

View ➪ Navigation Panels ➪ Articles to open a floating panel. Articles enable you to create article 
threads to help users follow passages of text in a logical reading order. You won’t find any new fea-
tures added to the Article tool since Acrobat 5.

CROSS-REFCROSS-REF For information on creating article threads and managing them, see Chapter 5.

Content
  A panel designed for managing the structural content of PDF documents is found in the Content 

panel. When you choose View ➪ Navigation Panels ➪ Content, the Content panel opens in a float-
ing panel as shown in Figure 1.45. Content features help you reflow tagged PDF files and manipu-
late the structure of tagged documents.

 FIGURE 1.45

The Content panel opens in a floating panel where the structural content of the open file is reported.

CROSS-REFCROSS-REF For information on working with the Content panel and tagged PDF documents, see 
Chapter 25.
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Destinations
  Destinations work similarly to bookmarks, in that specific views are captured and listed in the 

panel. Clicking a destination opens the associated page in the Document pane, whereas clicking a 
bookmark opens the associated view (page and zoom).

CROSS-REFCROSS-REF For information on creating destinations and managing them, see Chapter 22.

Layers
  If you create documents containing Adobe PDF layers, the Layers panel permits you to toggle layer 

views and work with layer properties. In Figure 1.46, the Layers panel is open showing visible and 
hidden layers.

 FIGURE 1.46

The Layers panel enables you to manage layer visibility.

CROSS-REFCROSS-REF To understand more about working with Adobe PDF layers, see Chapter 24.

Model Tree
  The Model Tree panel lets you examine information related to 3D drawings. You can review assets, 

hide and show drawing parts, toggle views, review comments, and more on 3D drawings. In 
Figure 1.47 you can see the model tree shown for a 3D image.

CROSS-REFCROSS-REF For more information about viewing 3D drawings and Acrobat 3D, see Chapter 2.

Order
  You use the Order panel to manage reading order of documents. This panel also relates to docu-

ment accessibility, like the options available in the Tags panel. The Order panel enables you to add 
tags to a document, clear tags, and reorder a page’s contents to change a reading order that might 
be read aloud by a screen reader.
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 FIGURE 1.47

The Model Tree panel is designed to work with 3D drawings.

CROSS-REFCROSS-REF For information on working with the Order panel, understanding screen readers, 
and document accessibility, see Chapter 25.

Tags
  Tagged PDF files provide more editing capability with PDF documents, and the files can be made 

accessible to adaptive devices such as screen readers. For adding, editing, and annotating tags in 
PDF documents, use the Tags panel. Together with the Content panel options, you have much 
control over document accessibility.

CROSS-REFCROSS-REF To understand accessibility and the advantages of creating tagged PDF documents, 
see Chapter 25.

Panel menus
Each of the panels contains its own pull-down menu. When a panel is open in the Navigation pane 
or in a floating window, select the Options down-pointing arrow to open a pull-down menu, as 
shown in Figure 1.48. Menu commands found in panels may or may not be available from the 
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top-level menu bar. Additionally, some panels, like the Attachments and Comments panels, offer 
you several pull-down menus.

 FIGURE 1.48

Panel Options menus provide menu commands specific to each panel function.

Context menus
Context menus can display different options for panel choices depending on where you open a 
context menu. If you move the cursor to an empty area when all text and objects in a panel are 
deselected and open a context menu, the menu options may be different than when you select text 
or an object in a panel. However, this is not always the case, because a few panels provide you with 
the same options regardless of whether something is selected or not. In Figure 1.49 a context menu 
is opened within the Bookmarks panel. In this case you need to open the menu on a bookmark 
name. If you attempt to open a context menu in an empty area in the pane, no menu opens.

 FIGURE 1.49

A context menu opened on a bookmark.
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Understanding Preferences
Preferences enable you to customize your work sessions in Acrobat. You can access a Preferences 
dialog box from within any Acrobat viewer and from within a Web browser when viewing PDFs as 
inline views. A huge number of preferences exist that all relate to specific tool groups or task cate-
gories, and it would not make as much sense to cover them here in the opening chapter as it 
would within chapters related to using tools and methods influenced by preference choices.

Some general things you should know about preferences is that they are contained in a dialog box 
as shown in Figure 1.50. You make a topic selection in the list on the left side of the dialog box 
and the related preferences are shown to the right side of the list. You make choices for preferences 
by selecting check boxes or making menu selections from pull-down menus. When you complete 
making your preference choices, click OK at the bottom of the dialog box.

Almost all the preferences you change in the Preferences dialog box are dynamic, which means you 
don’t need to quit Acrobat and relaunch the program for a preference choice to take effect. 
Preferences remain in effect until you change them again. If you quit Acrobat and relaunch the 
program, the preferences you last made are honored by Acrobat. However, if for some reason the 
program crashes and you don’t shut it down properly, any new preference changes will not be rec-
ognized when the program is launched again.

 FIGURE 1.50

Press Ctrl/Ô+K to open the Preferences dialog box. Click a category on the left and the choices are 
reflected to the left of the categories list.
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If you find some operation in Acrobat not working as you think it should, first take a look at the 
Preferences dialog box. In many cases you’ll find a check box or menu command not enabled to 
permit you to perform a task. As you become familiar with specific tool groups and menu com-
mands, make a habit of routinely visiting the Preferences dialog box so you understand all the tog-
gles and switches that affect tool and viewing behavior.

Summary
This chapter offers you a general introduction for working in Acrobat Standard Acrobat Pro and 
Acrobat Pro Extended and helps you understand the environment, the user interface, and some of 
the many new features added to the commercial Acrobat products. At the very least, you should 
know how to go about finding help when you first start working in the program. Some of the more 
important points discussed in this chapter include the following:

� Adobe Acrobat is a multifaceted program designed to provide solutions for many differ-
ent business professionals. Several types of Acrobat viewers exist, ranging in features to 
suit different user needs. The most sophisticated of the three viewers is Acrobat Pro 
Extended (Windows), now in version 9. Acrobat Standard (Windows only) offers fewer 
tools and menu commands than Acrobat Pro (Windows and Macintosh).

� PDF, short for Portable Document Format, was developed by Adobe Systems and was 
designed to exchange documents between computers and across computer platforms 
while maintaining file integrity.

� The PDF language format has changed version numbers along with the Acrobat viewers. 
Beginning in Acrobat 9, the PDF specification is no longer owned by Adobe. The 
International Organization for Standards now regulates the PDF specification.

� Tasks are performed through the use of menus, tools, and panels that can be accessed 
through mouse selections and keyboard shortcuts.

� The extensive list of tools appears in an abbreviated form when you open Acrobat and 
view the default toolbars. You can open additional toolbars from menu commands or the 
new More Tools window. You can dock toolbars in the Toolbar Well or float them 
around the Acrobat window.

� Panels are similar to toolbars in that they can be docked and undocked from a well called 
the Navigation pane. Panels contain pull-down menus, and some panels contain tools.

� You can customize the Acrobat workplace to suit your work style through the use of dif-
ferent preference choices. When preferences, panels, and toolbars are changed from their 
default views, the new views are saved when you quit your Acrobat session. They remain 
unchanged until you change them again or reset them to defaults.

� Preferences are settings that apply globally to Acrobat and influence the behavior of tools 
and menu commands.
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